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1.0 Purpose and Scope 
1.1 This document serves as the Product Testing (PT) Standard Operating Procedure (SOP) 

for the operation of the Thermo Scientific Nicolet iS5 Fourier Transform Infrared 
Spectrometer (FTIR) utilizing the attenuated total reflectance (ATR) accessory. 

2.0 Applicability 
2.1 The SOP details the operational methods and parameters for data collection using the 

FTIR instrument. This SOP also includes methods for instrument safety, training, 
verification, quality assurance, and basic maintenance/troubleshooting of the FTIR as a 
screening tool. The ability of the instrument in determining the presence of these 
chemicals are dependent on the availability of the standards or spectra. 

2.2 Product testing XRF screening data are collected to help select samples for further 
confirmatory laboratory analysis. This method is designed as a rapid screening tool, and 
is not accredited. 

3.0 Definitions  
3.1 Absorption –The transfer of energy from an electromagnetic radiation to molecules that 

are present in the path of the radiation.  
3.2 Attenuated Total Reflectance (ATR) – A sampling technique used in conjunction with 

infrared spectroscopy which enables samples to be examined directly in the solid or 
liquid state without further preparation. 

3.3 ATR Correction – A correction applied to a spectrum obtained using the ATR diamond 
crystal accessory that accounts for absorption band shifts and variation in depth of 
penetration. This allows for the acquired spectrum to be compared against the spectra 
collected using standard transmission techniques.  

3.4 Background spectrum – A signal-beam spectrum captured without a sample in place. 
This spectrum captures the characteristics of the environment of the spectrometer, 
including the source, detector, and atmospheric conditions.  

3.5 Component – Individual piece or part of a product containing different colors, 
functions, and/or material (For example, a sweater may be comprised of several 
components such as, the woven fabric, a button, and a zipper).  

3.6 Component Sample – Component identified to be screened as a sample using the FTIR. 
Components cataloged in the PTDB receive an alpha-numeric identification (ID) that is 
used as the FTIR component ID (e.g. TG-1-1-1). 

3.7 Fourier Transform – The mathematical operation used to convert an interferogram that 
contains data in a time domain to a single beam spectrum that contains data in a 
frequency domain in order to reveal the response at all frequencies within a spectral 
range.  

3.8 Fourier Transform Infrared Spectroscopy – A spectroscopic technique that uses an 
interferometer to collect data and a Fourier transform to digitally process the data. 
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3.9 Infrared Radiation – A region of the electromagnetic spectrum extending from 
approximately 10 to 14000 cm-1. The Far Infrared extends from 400 to 10 cm-1, the 
Mid Infrared extends from 400 and 4000 cm-1, and the Near Infrared extends from 
4000 to 14000 cm-1. 

3.10 Infrared Spectroscopy – A spectroscopic technique used to identify molecular structure 
using electromagnetic radiation in the mid-infrared region. A sample placed in the path 
of an infrared beam absorbs some of the radiation and transmits the rest. Absorption of 
this infrared radiation is a function of the vibrational or rotational energy of molecular 
structures present in the sample. Since, different molecular structures absorb at different 
frequencies each molecular structure has a unique molecular fingerprint which can be 
used to identify chemical compositions of a sample.  

3.11 Initial Demonstration of Capability (IDC) –IDC is the process of documenting a new 
users’ ability to operate the FTIR using the ATR accessory. A new operator must be 
able to collect a complete set of spectra with the instrument under minimal supervision 
and complete the Initial Demonstration of capability (IDC) Form for FTIR. The analysis 
consists of running a performance verification check, collecting spectrum of a check 
sample, and five random samples using the ATR accessory. A copy of the completed 
IDC form with appropriate signatures should be stored in the FTIR Performance 
Verification (PV) and IDC Records Log Book in the PT Room. The trainee should also 
keep a copy for their own records. 

3.12 Interferogram – An electronic recording of an optical interference pattern that plots 
infrared intensity versus the optical path difference.  

3.13 Interferometer – An optical device used to measure all the infrared frequencies 
simultaneously. It produces an interferogram that holds information on the rotational 
and vibrational frequencies of a particular molecular structure which is translated to a 
spectrum using the Fourier Transform   

3.14 Spectrum – In chemistry, a spectrum refers to the characteristic wavelength of 
electromagnetic radiation that is emitted or absorbed by an object or substance, atom or 
a molecule. 

3.15 Wavelength – A unique span of measured electromagnetic energy from crest to crest. 
The shorter the wavelength the more energy it contains. 

3.16 Wavenumber – The number of waves that fit in a centimeter, the inverse of a 
wavelength. Wavenumbers are expressed in cm-1 and are proportional to energy. They 
are most often represented in the X-axis of a spectrum. 

4.0 Personnel Qualifications/Responsibilities  
4.1 Staff must receive training and perform a successful Initial Demonstration of Capability 

(IDC) prior to operating the FTIR. A qualified operator will provide the training. A 
qualified operator is a permanent employee that has been trained to operate the FTIR by 
another qualified operator. 

4.2 Employees may also receive training through qualified Thermo technicians and or other 
formal training opportunities to become a qualified operator. 
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4.3 All operators should review the FTIR Nicolet iS5- Getting Started, Fast Facts Sheet, 
and Site and Safety information booklets available in the Product Testing (PT) 
Preparation Room (OL-21).  

4.4 For new operator training, the overseeing qualified operator will be responsible for 
supplying the new operator with the following: 

4.4.1 Initial Demonstration of capability (IDC) Form for FTIR 
4.4.2 A copy of this SOP 
4.4.3 Hands on training 
4.4.4 Documents listed in Section 4.3 
4.4.5 Administering IDC analysis 
4.4.6 Continued oversight and review of the operator’s first several FTIR operation sessions. 
4.4.7 The qualified operator will also provide a signature to sign off on the IDC Form for 

FTIR when complete. 
4.5 The completed training documentation shall be submitted to the PT Management for a 

final signature and record retention. A copy will be stored in the PT Room in the FTIR 
Performance Verification (PV) and IDC records Logbook. The trainee should also keep 
a copy for their own records. 

4.6 Upon completion of the training with a successful IDC, and when all appropriate 
signatures are obtained, the operator is qualified to collect data using the FTIR.  

4.7 IDC must be performed initially for every new operator. Ongoing demonstration will be 
performed for each current operators at the recertification of this SOP, when there is a 
change to the procedure, and at deployment of a new instrument. Use the IDC Form for 
FTIR to document on-going demonstration of capability. 

4.8 Personnel Responsibilities: 
4.8.1 Always operate the FTIR in accordance with this SOP. The SOP is based on the 

guidance established in accordance with manufacturer’s instructions and 
recommendations.  

4.8.2 All Ecology health and safety guidelines described in Section 9.0 must be followed as 
specified. 

4.8.3 The PT Sample Collection and Processing SOP should be followed for the tool cleaning 
protocols, and deconstruction and preparation of component samples. This SOP which 
is specific to preparing component samples for XRF screening is also applicable for 
preparing component samples for screening with the FTIR.  

4.8.4 Study specific Quality Assurance Project Plans (QAPPs) shall be reviewed for 
additional product deconstruction, preparation, and analysis procedures prior to the 
beginning of screening component samples.  
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4.8.5 The FTIR operator will be responsible for verifying the completeness and correctness of 
data acquisition in accordance with this SOP and any additional guidance pre-
established in study-specific QAPPs. Errors made during data collection (e.g., sample 
ID typos, incomplete scans) are recorded in the FTIR Error Log during the data 
collection session.  

4.8.6 All corrections made to the file mentioned in section 4.8.5 will be documented as a case 
narrative (word document) to be saved to the PTDB as an attachment. The file should 
be saved with a standard filename format that says “Project Name FTIR case narrative” 
and has the analysis date. (Project Name FTIR Case Narrative-mm-dd-yyyy). (For 
Example: ProjectNameFTIRCaseNarrative10-21-2019) 

4.8.7 The project manager (PM) will inspect datasets and case narratives uploaded to the 
Product Testing Database (PTDB) to verify accuracy, completeness, and adherence to 
the specific study criteria. 

5.0 Equipment, Reagents, and Supplies 
5.1 Thermo Scientific Nicolet iS5 FTIR (S/N: ASB1502454) 
5.2 iTR-iD5 ATR accessory with high pressure tower/clamp (Thermo P/N 869-128600) 
5.3 Solid (nylon) press tip specific for use with the diamond crystal (Thermo P/N 869-

128600) 
5.4 Diamond iTR-iD5 3-Bounce ATR crystal (Pike P/N: 025-2114) or Diamond iTR-iD5 

Hastelloy Diamond Plate (single-bounce ATR crystal; Thermo Item # 869-129400)   
5.5 OMNIC software and Adobe Acrobat Reader  
5.6 Lab samples, referred to as CHK SMP 1, and CHK SMP 2 (previously analyzed in the 

lab for known amounts of ortho-phthalate analytes)  
5.7 Crystal cleaning agents: 24% ethanol (recommended)  
5.8 De-ionized water (DIW) in squirt bottles. 
5.9 Kim Wipes, or other optical grade wipes 
5.10 Nitrile gloves 
5.11 Forceps 
5.12 Glass pipettes and pipette bulbs for transferring liquid samples. 
5.13 FTIR Instrument Log (Maintenance Records) 
5.14 IDC and FTIR Performance Verification Record Log (Record of IDC and Performance 

Verification (PV) Tests) 
5.15 FTIR Daily Log (Record of samples scanned) 
5.16 FTIR Error Log (Record of errors during screening) 
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6.0 Summary of Procedure 
6.1 Spectra Collection Pre-Checks: 

6.1.1 The humidity level inside the instrument must be monitored routinely to maintain 
proper operation of the instrument. A desiccant cartridge located in the back of the 
instrument maintains the humidity level of the instrument. The operator should check 
the desiccant indicator and document the desiccant indicator color on the FTIR Daily 
Log before running a screening session on the instrument. 

6.1.2 Note: Replace the desiccant when the humidity indicator turns pink (can be light pink or 
almost white) or the software displays a message that the internal humidity is above 
50%. Also replace the paper humidity indicator each time the desiccant is replaced. Any 
time the desiccator is replaced it should be recorded in the FTIR Instrument Log. 

6.1.3 A blue light on the front panel of the instrument indicates that it is ON. For an 
instrument that is turned off, turn it on using the toggle switch at the back of instrument. 
The instrument should warm up for a minimum of 30 minutes prior to operation. 

6.1.4 Some wireless devices may affect instrument performance. Move all wireless devices at 
least 2.0 m (6.5 ft.) away from the instrument.  

6.1.5 Refer to Appendix A to get acquainted with the different parts of the instrument. The 
instrument is equipped with interchangeable accessories to run the spectrometer in 
transmission (iD1) and Attenuated Total Reflectance (iD5) mode. For procedures 
outlined in this SOP, only the iD5 ATR accessory is used. 

6.1.6 The product testing prep room has two interchangeable diamond crystals that can be 
used with the iD5 ATR accessory: the single-bounce diamond and the triple-bounce 
diamond. 

6.1.7 The single-bounce crystal is more durable and is recommended for use with any type of 
materials. Ideal materials that can be analyzed with the single-bounce crystal are 
homogeneous solid samples (rigid or flexible) such as laminates, plastics, rubbers, 
powders, as well as free flowing or viscous liquids.  

6.1.8 The triple-bounce crystal is more sensitive (can generate signals at lower 
concentrations) but is recommended only for use with homogeneous bendable solids 
and free flowing liquids. The manufacturer recommends using only the plastic press tip 
with the triple-bounce crystal.  
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Figure 1. The single-bounce crystal plate with a small sampling aperture (Left) & the triple-bounce crystal plate 

with a larger aperture and a gold line across the center. (Right) 

6.1.9 It is recommended that abrasive liquids and any other liquids (viscous or free flowing) 
that cannot be cleaned off with an alcohol-based solvent not be analyzed with either 
crystal. 

6.1.10 The project manager may choose to use one or both crystals depending on the type of 
materials being analyzed in a study. For more information on choosing a crystal refer to 
videos available in the “reference links” sections of the “Screening Instruments” page 
on the Product Testing SharePoint Site. 

6.1.11 At the adjoining computer, log on with your User Name and password, then open the 
“OMNIC” icon on the Desktop. The software works from any user ID.  

6.1.12 Check the System Status by clicking on the System Performance Verification shield 
icon in the upper right corner of the Omnic software interface. 

6.1.13 If the System Status shield is green move on to the next step. If the System Status shield 
is yellow it may indicate that the system identified a minor problem, which should be 
viewed to determine the possible effects on the data collected. Follow the instructions 
on the System Status Overview which will identify the issues to be addressed. If the 
System Status shield is red, it warns that the system is out of specification, or a 
subsystem failed. It may also indicate that a Performance Verification (PV) test may be 
required. 

6.1.14 Please refer to Appendix B for checking system status and running a PV test. 
Requirement for running a PV test is auto-programmed to be triggered at the beginning 
of each month.  

6.1.15 Prior to any data collection using the ATR, the surface of the crystal should be cleaned.  
6.1.16 For initial cleaning and cleaning between samples, dampen a Kim wipe with a small 

amount of 24% ethanol, and then gently wipe the surface of circular crystal and 
surrounding sample platform from top to bottom or left to right. (Never scrub the 
surface of the diamond crystal in a circular motion.) 

6.1.17 Note: Acetone must never be used on the diamond ATR. Use of incompatible solvents, 
or samples containing such solvents, will damage/delaminate the ATR crystal. 
Delamination of the crystal by a solvent is not covered under the manufacturer 
warranty. 

6.1.18 To clean the solid/plastic press tip, gently pat the underside with wetted Kim Wipe.  
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6.1.19 Even though it is highly unlikely that contamination will pass or be detected during 
testing of solid materials on the FTIR from the press tip, it is best practice to clean the 
press tip in between each sample. 

6.1.20 Note: While running the FTIR in ATR mode with the triple-bounce crystal, the pressure 
clamp should not be used without a plastic tip. It may damage the ATR crystal. The 
pressure clamp is not necessary when running liquid samples. 

6.2 Experiment Parameters Setup:  
6.2.1 Conduct the following steps before every scanning session to ensure correct setup for 

data collection: 
6.2.2 For plastics screening and phthalates analysis the default FTIR operating configuration 

is set as “Phthalate Analyzer” and the default experiment is “Phthalates and Plastics 
Screening.” The analyst should verify that the correct experiment is loaded by checking 
the experiment heading located at the top of the OMNIC screen.  

6.2.3 To set scan parameters: Collect – Experiment set up—Collect.  
6.2.4 No. of scans default is 16. If different, set it to 16.  
6.2.5 Resolution: 4 is fine. If small amplitude noise is a problem in your spectra, try 

increasing the number to 6 or more. 
6.2.6 Final format: Absorbance 
6.2.7 Correction: None  
6.2.8 Check the box for “Preview data collection,” the other three boxes should be 

unchecked. 
6.2.9 File Handling: Uncheck box for “save automatically.” Verify that the “save 

interferogram” box is checked.  
6.2.10 Background Handling: Choose “Collect background after 120 minutes.” This directs the 

software to generate a prompt for obtaining a new background at intervals of 120 
minutes. Make sure to collect a new background when the prompt occurs.  



 

PTP005, Version 1.1 — Revised April 2021 
Uncontrolled copy when printed 

— Page 10 — 

 
Figure 2. Omnic experiment setup screen for setting up data collection parameters 

6.2.11 To check beam, click the bench tab (if window is closed then reopen by ‘Collect’ – 
Experiment set up – Bench): If something is wrong with the beam, an error message 
will pop up. Call the Thermo rep for troubleshooting when this occurs. For ATR, click 
peak to peak button to verify the height of the interferogram which should be between 6 
and 8. 

 
Figure 3. Omnic bench tab screen to check peak to peak height 



 

PTP005, Version 1.1 — Revised April 2021 
Uncontrolled copy when printed 

— Page 11 — 

6.2.12 Click “Save” button to ensure that any changes made have been saved to the experiment 
setup, and then click OK to exit. 

6.3 Background Collection:  
6.3.1 Collection of a background signal is essential for the instrument to generate a spectrum 

for a sample screened. Make sure that the crystal surface is clean and dry before 
collecting a background. The pressure clamp needs to be loosened to ensure that the 
press tip is not touching the crystal surface when the background is being collected. 
Move the solid press tip away from the sample plate.  

6.3.2 Note: Collect a new background at the beginning of each session. A new background 
should be collected at an interval of 120 minutes. (Follow system prompt.) 

6.3.3 Click on either one of Col Bkg icons, and press OK when prompted by the dialog box to 
proceed with the background collection. 

 

 

Figure 4. Omnic menu screen with the collect background button highlighted 

6.3.4 A preview screen with the background is displayed on the screen. Hit “Start Collection” 
(in the upper right corner) to start the background collection process.  

 
Figure 5. Omnic screen start collection button to begin data collection  

6.3.5 After the 16 scans have been completed, a dialog box will appear; select “No.” It is not 
necessary to save the background for it to auto correct.  
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Figure 6. Add to window popup 

6.3.6 Note: The OMNIC Specta software ratios the collected background to the sample 
spectrum to get rid of the absorption curve from the diamond and it also zeroes out any 
water vapor and CO2 in the sample spectrum.  

6.3.7 Note: Water vapor and CO2 peaks will start appearing in your sample spectra as the 
concentrations in the air can fluctuate near the spectrometer and, could affect the 
background. Water in particular can interfere with the background spectra, for more 
details see excerpt from the Pre-Webinar Training Guide 3 - “When do you need a new 
background” provided by Ecology Center (Appendix D).  

6.4 Choosing the correct library setup: 
6.4.1 Before screening samples ensure that the correct spectral libraries have been selected. 

Depending on the class of chemicals that are to be identified different libraries can be 
selected. The optimum selection of libraries for identifying plastic class and running the 
DI water blank and phthalate check samples have been predetermined. The PM may 
provide instructions on a different library selection depending on a particular study. 

6.4.2 For plastic class identification: 
6.4.2.1 Analyze – Library Setup –Select “Polymer class identification” from the “Available 

search libraries and groups” table on the left and click Add>>. A list of selected 
Polymer Libraries is then displayed in the Search libraries and groups table. Ensure the 
following libraries are displayed on the right table: 

6.4.2.1.1 HR Aldrich Alcohols and Phenols 
6.4.2.1.2 HR Hummel Polymer and Additives  
6.4.2.1.3 HR Polymer Additives and Plasticizers  
6.4.2.1.4 HR Specta Polymers and Plasticizers by ATR 
6.4.2.1.5 HR Specta Polymers and Plasticizers by ATR-Corrected  
6.4.2.1.6 Hummel Polymer Sample Library  
6.4.2.1.7 SRL PVC Plasticizer Analysis 

6.4.2.2 Remove any other libraries by selecting from the table on the right and clicking 
<<Remove. Click OK to exit the library setup screen. 

6.4.3 For collecting Di water blank spectrum and running phthalate check samples: 
6.4.3.1 Click Analyze – Library Setup –Select “Phthalates analysis” from the “Available search 

libraries and groups” table on the left and click Add>>. A list of selected plasticizer and 
additive libraries are then displayed in the Search libraries and groups table. Ensure the 
following libraries are displayed on the right table: 

6.4.3.1.1 HR Aldrich Alcohols and Phenols  
6.4.3.1.2 HR Polymer Additives and Plasticizers  
6.4.3.1.3 Hummel Polymer Sample Library  
6.4.3.1.4 SRL PVC Plasticizer Analysis 
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6.4.3.2 Remove any other libraries by selecting from the table on the right and clicking 
<<Remove. Click OK to exit the library setup screen. 

6.5 Collecting a DI water blank spectrum and running phthalate check samples: 
6.5.1 Prior to running any unknown samples, a check verification of the instrument is 

conducted by assessing the instruments’ ability to identify the class of ortho-phthalates 
using commercially available standards or lab samples that have known amounts of 
ortho-phthalates. 

6.5.2 *Note: A De-ionized (DI) water blank is collected each time before running a set of 
check verification samples.  

6.5.3 Running a check verification consists of completing two different tasks: 
6.5.3.1 At first, the previously analyzed lab samples (CHK SMP 1 and CHK SMP 2 available 

in the Product Testing Prep Room ROL-21) with a known concentration of an ortho-
phthalate are scanned using the FTIR. The specific peaks associated with these ortho-
phthalates are then identified as being present. Information on commonly known ortho-
phthalate peaks can be found in Appendix C. 

6.5.3.2 Next the scanned spectrum of the CHK SMP1 and CHK SMP 2 are compared to other 
spectra in a commercial library to obtain a positive match for the known lab sample 
ortho-phthalate. The scan will also most likely identify a positive match for other ortho-
phthalates. Since the screening instrument is to be used to identify only the presence or 
absence of ortho-phthalates, all identified matches should have a match % of greater 
than 60%. 

6.5.4 *Disclaimer: Previously analyzed laboratory samples (CHK SMP1 and CHK SMP 2) 
used in the process for verifying the instrument’s ability to identify the class of ortho-
phthalates were analyzed using methods that have been updated by the WA State 
Accreditation Board. These samples are used to roughly demonstrate the instrument’s 
ability to screen for phthalates and are not to be considered as standards. 

6.5.5 Print the FTIR Sample Check Verification Log available in the Product Testing 
SharePoint site. This log is to be filled out with information obtained from both Check 
Verification Samples. 

6.5.6 Before collecting the spectrum of the DI water blank and running phthalate check 
samples ensure that the correct spectral libraries have been selected. 

6.5.6.1 Click Analyze – Library Setup –Select “Phthalates analysis” from the “Available search 
libraries and groups” table on the left and click Add>>. A list of selected plasticizer and 
additive libraries are then displayed in the Search libraries and groups table. Ensure the 
following libraries are displayed on the right table: 

6.5.6.1.1 HR Aldrich Alcohols and Phenols  
6.5.6.1.2 HR Polymer Additives and Plasticizers  
6.5.6.1.3 Hummel Polymer Sample Library  
6.5.6.1.4 SRL PVC Plasticizer Analysis 
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6.5.6.2 Remove any other libraries by selecting from the table on the right and clicking 
<<Remove. Click OK to exit the library setup screen.  

6.5.7 After the background (see section 6.3) has been collected click on Col Smp icon to 
begin collecting the spectrum. 

 

 

 

Figure 7. Omnic menu screen with the collect sample button highlighted 

6.5.8 A prompt for entering the spectrum name appears. Enter the sample name “DI water 
Blank” in front of the time date stamp, and Press OK. 

Figure 8. Omnic popup screen for entering spectrum name 

6.5.9 A prompt appears “Please prepare to collect the sample spectrum.” Click OK to 
proceed.  

6.5.10 A preview screen with a flat baseline should appear from 4000 to approximately 650 
wavenumbers. If the ATR crystal is not clean the baseline may appear to have peaks. In 
case of unwanted peaks, clean the crystal and sample platform with 24% ethanol and 
wait for it to air dry. 

Figure 9. Omnic data collection preview screen 

6.5.11 Once a flat baseline is achieved, squirt a few drops of DI water on the crystal surface, 
and press start collection button in upper right corner. 

6.5.12 Note: The solid/plastic press tip is not necessary for liquid samples. 
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Figure 10. Omnic data collection screen during data collection 

6.5.13 After scanning is completed choose “Yes Add to Window” option on the popup that 
appears. 

6.5.14 A prompt may appear asking for a window label. Click OK to automatically choose the 
default window label. (window 1, window 2….etc) 

6.5.15 Correct the baseline of the spectrum by clicking on the Process Tab and choosing the 
Automatic Baseline Correct option.  

6.5.16 A new baseline corrected spectrum highlighted in red is added to the current window. 

 
Figure 11. Omnic data collection screen with a new baseline corrected spectrum 

6.5.17 Hide the old raw spectrum (spectrum without the corrected baseline) from the current 
window by first clicking on it to highlight it in red, and then pressing CTRL+H. 
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6.5.18 Run the spectral match by pressing on the Analyze Tab and clicking on the Search 
button. 

 

 

Figure 12. Omnic spectral database search results screen 

6.5.19 Once the result is obtained verify that water (H2O) Deuterium-Depleted is identified in 
the results and has the highest match % (at minimum, greater than 60%). Also identify 
that there are no false phthalate matches.  

6.5.20 Save a digital copy of the spectrum with identified matches as a PDF by clicking on the 
print button and choosing the Adobe PDF option. 

Figure 13. Using the print to PDF function in Omnic 

6.5.21 Note: Using the Save function in the software does not save any analysis results such as 
labeled peaks or library comparisons. Print to PDF option works best for saving the 
spectrum with results. 

6.5.22 Save the PDF file with a standard filename that includes the date, sample ID. 
(mmddyyyy Sample ID). For example (10102019 DI Water Blank) 

6.5.23 The file should be saved in a FTIR folder, in the specific study folder created by the PM 
in F: drive. If there is no FTIR folder under the specific study create a new one. 
F:\EAP\TSU\ProductTesting\SpecificStudyName\FTIR 
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6.5.24 Once the PDF has been saved print a hard copy for records.  
6.5.25 Save the .SPA file by clicking on the File tab located on the top left side of the screen 

and choosing “Save As.” Use the same filename format and location mentioned above 
to save the .SPA file in the same study specific folder. 

6.5.26 Once the DI water blank has been screened, gently wipe the DI water off the crystal 
surface using a Kim wipe. Dampen a Kim wipe with a small amount of 24% ethanol 
and gently wipe the surface of circular crystal and surrounding sample platform from 
top to bottom or left to right. (Never scrub the surface of the diamond crystal in a 
circular motion) 

6.5.27 Close the result screen by clicking the Close button on the bottom right of the screen. 

 
Figure 14. Highlighted close button at the bottom of the library match screen 

6.5.28 After closing the results or library match screen, the processing window displays the 
original spectrum and all other spectra obtained (Baseline corrected, and ATR 
corrected). Just close this window to start a new sample. Make sure to choose the 
correct close button as shown in figure below. Choosing the wrong close button may 
terminate the OMNIC program. 

 
Figure 15. Close icon for closing the current data collection screen 

6.5.29 Click on Col Smp button to begin collecting the spectrum for the 1st check verification 
sample.  

6.5.30 A prompt for entering the spectrum name appears. Enter the check sample name “CHK 
SMP 1” in front of the time date stamp and Press OK. 

6.5.31 A prompt appears “Please prepare to collect the sample spectrum.” Click Ok to proceed. 
6.5.32 A preview screen with a flat baseline should appear from 4000 to approximately 650 

wavenumbers. If the ATR crystal is not clean the baseline may appear to have peaks. In 
case of unwanted peaks, clean the crystal and sample platform with 24% ethanol and 
wait for it to air dry.  
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6.5.33 Once a flat baseline is achieved, use dedicated tweezers (tweezers should be cleaned 
with Kim Wipes wetted with 24% ethanol in between each use) to carefully place the 
1st check sample CHK SMP 1 on the crystal surface and tighten the pressure clamp. 
Best results are obtained when the sample is pressed flat against the crystal. Once the 
sample is pressed flat on the surface the pressure tower needs to be tightened till a click 
is heard or felt. 

6.5.34 Note: Be careful to keep an eye on the solid press/plastic tip while tightening. To ensure 
that the plastic tip does not break, it should rest flat on the surface of the material and 
stay in a horizontal alignment as much as possible when tightening. 

6.5.35 Press start collection button in upper right corner to begin scanning.  
6.5.36 After scanning is completed choose “Yes Add to Window” option on the popup that 

appears. 
6.5.37 A prompt may appear asking for a window label. Click OK to automatically choose the 

default window label. (Window 1, window 2…, etc.) 
6.5.38 Correct the baseline of the spectrum by clicking on the Process Tab and choosing the 

Automatic Baseline Correct option.  
6.5.39 A new baseline corrected spectrum highlighted (*is corrected spectrum) in red is added 

to the current window.  
6.5.40 Hide the old raw spectrum (spectrum without the corrected baseline) from the current 

window by first clicking on it to highlight it in red, and then pressing CTRL+H.  
6.5.41 Click on the Analyze Tab and select ‘Find Peaks’ button to label the peaks in the 

spectrum. A black line runs through the middle of the screen and labels all the peaks 
above it with their respective wavenumbers. Click at the bottom of the spectrum 
window above the Y-axis to move the line to the bottom in order to label smaller peaks. 

 
Figure 16. Using the find peaks function to analyze the spectrum 
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6.5.42 Check to verify that all the peaks on the check verification log table below have been 
identified. Some desired peaks on the check verification log table that do not have a 
peak label, (most often peak at 1595 wavenumber) can be added by increasing the 
threshold on the sensitivity bar located to the left of the screen. 

Table 1. Check verification log 

Wavenumber ( cm-1) Measured 
Wavenumbers  
CHK STD 1 

Measured 
Wavenumbers CHK 
STD 2 

Result  

Peak at 1725 ± 5    
Peak at 1595 ± 5    

Peak at 1580 ± 5    
Peak at 1120 ± 5    
Peak at 1070 ± 5    
Peak at 740 ± 5    
Diisononyl phthalate 
>60% 

   

Di(2-ethylhexyl) 
phthalate >60% 

   

 
Figure 17. Increasing the sensitivity to find lower peaks in the spectrum, and use replace button to add the 

labeled spectrum to the Omnic data collection screen   
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6.5.43 Once all the desired peaks have been labeled, click on the Replace button located on the 
top right corner of the OMNIC window to add the processed spectrum with identified 
peaks to the current window.  

6.5.44 Adjust the window to include only the wavenumbers associated with phthalate peaks by 
pressing CTRL+D and choosing the start of the X-axis limit at 1800 wavenumbers. 

 
Figure 18. Popup for adjusting the X-axis view scale 

6.5.45 Save a digital copy of the spectrum with identified peaks as a PDF by clicking on the 
print button and choosing the Adobe PDF option.  

6.5.46 Save the PDF file with a standard filename that includes the date, sample ID, task 
description (mmddyyyy SAMPLE ID TASK DESCRIPTION) For example (10102019 
CHK SMP1 FIND PEAKS) 

6.5.47 The file should be saved in a FTIR folder, in the specific study folder created by the PM 
in F: drive. If there is no FTIR folder under the specific study create a new one. 
F:\EAP\TSU\ProductTesting\SpecificStudyName\FTIR 

6.5.48 Also, save the .SPA file by clicking on the File tab located on the top left side of the 
screen and choosing “Save As.” Use the filename format (mmddyyyy Sample ID) to 
save the .SPA file in the same study specific folder. For example (04202021 CHK 
SMP1) 

6.5.49 Print a copy and fill out the measured wavenumbers for CHK SMP 1 in the FTIR 
Sample Check Verification Log. 

6.5.50 The next step is to compare the spectrum of the collected check verification sample 
against the spectra available in commercial spectral library databases. Run the spectral 
match by pressing on the Analyze Tab and clicking on the Search button. 
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Figure 19. Omnic spectral database search results 

6.5.51 Once the result is obtained verify that the Diisononyl phthalate is identified in the 
results at a match % of greater than 60%, and all other ortho-phthalates identified also 
have a match of greater than 60% for CHK SMP1.  

6.5.52 Note: If the search results does not find a match for the desired phthalates, go back to 
the library setup, and delete all the libraries from the “search libraries and groups” and 
then reselect the “phthalates analysis” group before running the search again.  

6.5.53 In the Sample Check Verification Log fill out the measured wavenumber column for 
Diisononyl phthalate with the match % obtained. If the match % obtained is greater than 
60% write pass on the results column. If the match obtained is less than 60% the sample 
check verification has failed. In case of failure remove the sample, clean the sample 
surface, and rescan a different surface on the check sample.  

6.5.54 Click the print button to save a digital copy of the results obtained. Click the printer 
setup button on the popup screen and set the printer name to Adobe PDF. Press OK on 
both the popups. Navigate to the designated FTIR folder mentioned above in the F: 
drive under the specific study and save with a standard filename such as 10092019 
CHKSMP1 library match. Then print a physical copy to be filed. 

6.5.55 Remove CHK SMP 1 from the sample holder and clean the crystal surface and the 
solid/plastic press tip with alcohol and wipes. Wait till the surface is completely dry 
before proceeding with CHK SMP 2.  

6.5.56 Close the result screen by clicking the Close button on the bottom right of the screen. 
6.5.57 After closing the results screen, the processing window displays the original spectrum 

and all other spectra obtained (Baseline corrected). Just close this window to start a new 
sample. 
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6.5.58 Repeat the steps of collecting a sample spectrum, correcting the baseline, and finding 
peaks with the lab sample CHK SMP 2. Save a digital copy of the spectrum with a 
standard filename such as 10092019 CHKSMP2 Find Peaks and save it to the FTIR 
folder under the specific study in F: drive. 

6.5.59 After a digital copy has been saved, print a copy, and fill out the table in the Sample 
Check Verification Log for Analysis of Phthalates with measured wavenumbers for 
CHK SMP 2. 

6.5.60 Also, save the .SPA file by clicking on the File tab located on the top left side of the 
screen and choosing “Save As.” Use the filename format (mmddyyyy Sample ID) to 
save the .SPA file in the same study specific folder. For example (04202021 CHK 
SMP2) 

6.5.61 Repeat the process for finding library matches. Verify that Di (2-ethylhexyl) phthalate 
is present and all other ortho-phthalates identified are at >60% for CHK SMP 2.  

6.5.62 In the Sample Check Verification Log fill out the measured wavenumber column for Di 
(2-ethylhexyl) phthalate with the match % obtained. If the match % obtained is greater 
than 60% write pass on the results column. If the match obtained is less than 60% the 
sample check verification has failed. In case of failure remove the sample, clean the 
sample surface, and rescan a different surface on the check sample.  

6.5.63 Click the print button to save a digital copy of the results obtained. Click the printer 
setup button on the popup screen and set the printer name to Adobe PDF. Press OK on 
both the popups. Navigate to the designated FTIR folder mentioned above in the F: 
drive under the specific study and save with a standard filename such as 10092019 
CHKSMP2 library match. Then print a physical copy to be filed. 

6.5.64 A completed sample check verification packet should be filed in the Data Entry and 
Review Checklist folder under the associated study. It must have a filled out sample 
check verification log, spectra with labeled peaks for both check samples and, spectral 
library comparison results for the blank and both of the check verification samples.  

6.5.65 Once the sample check verification process has been completed for both check samples 
with satisfactory results (pass in all categories), the analyst can proceed to screening of 
unknown samples. 

6.6 Sample Screening for plastic class identification, plasticizers and additives, and other 
organic contaminants: 

6.6.1 Extensive preparation is not necessary for analyzing a material (sample), however size 
reduction may be necessary to allow for the pressure tower to be used in pressing the 
sample to the crystal surface. Follow procedures outlined in Product Testing’s 
Consumer Products Sample Collection and Processing SOP for processing the samples 
for screening by XRF. The sample processing method for screening is identical for both 
instruments.  

6.6.2 Best results are obtained when the sample is pressed flat against the crystal. Once the 
sample is pressed flat on the surface the pressure tower needs to be tightened till a click 
is heard or felt. 
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6.6.3 Note: Be careful to keep an eye on the plastic tip while tightening. To ensure that the tip 
does not break, it should rest flat on the surface of the material and stay in a horizontal 
alignment as much as possible when tightening. 

6.6.4 Use extreme caution when screening liquid samples. Do NOT screen liquids that may 
need acetone or strong acids and bases for cleanup. Any samples suspected of having 
these types of compounds should not be screened using the FTIR.  

6.6.5 For thick viscous samples such as nail polish and paints that can be desiccated, it is best 
to dry it on a glass surface or XRF sample cup in a fume hood to convert it into a solid 
chip before analyzing it on the FTIR crystal.  

6.6.6 Follow steps in section 6.4 to determine the correct library setup before scanning.  
6.6.7 Clean the crystal surface prior to screening each sample to eliminate any cross 

contamination between samples. 
6.6.8 Col Smp icon to begin collecting the spectrum.  
6.6.9 A prompt for entering the spectrum name appears. Enter the sample name “Component 

ID” in front of the time date stamp and Press OK. 
6.6.10 A prompt appears “Please prepare to collect the sample spectrum.” Click Ok to proceed.  
6.6.11 A preview screen with a flat baseline should appear from 4000 to approximately 650 

wavenumbers. If the ATR crystal is not clean the baseline may appear to have peaks. In 
case of unwanted peaks, clean the crystal and sample platform with 24% ethanol and 
wait for it to air dry.  

6.6.12 Once a flat baseline is achieved, use dedicated tweezers (tweezers or non-phthalate 
gloves should be cleaned with Kim Wipes wetted with 24% ethanol in between each 
use) to carefully place the desired sample on the crystal surface and tighten the pressure 
clamp. Best results are obtained when the sample is pressed flat against the crystal. 
Once the sample is pressed flat on the surface the pressure tower needs to be tightened 
till a click is heard or felt. 

6.6.13 Note: When using the plastic tip with the triple-bounce crystal be careful to keep an eye 
on the plastic tip while tightening. To ensure that the tip does not break, it should rest 
flat on the surface of the material and stay in a horizontal alignment as much as possible 
when tightening. 

6.6.14 Press the “start collection button” in upper right corner to begin scanning. 
6.6.15 After scanning is completed choose “Yes Add to Window” option on the popup that 

appears. 
6.6.16 A prompt may appear asking for a window label. Click OK to automatically choose the 

default window label. (Window 1, window 2….etc) 
6.6.17 Correct the baseline of the spectrum by clicking on the Process Tab and choosing the 

Automatic Baseline Correct option.  
6.6.18 A new baseline corrected spectrum highlighted in red is added to the current window.  
6.6.19 Hide the old raw spectrum (spectrum without the corrected baseline) from the current 

window by first clicking on it to highlight it in red, and then pressing CTRL+H. 
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6.6.20 Run the spectral match by pressing on the Analyze Tab and clicking on the Search 
button. 

6.6.21 Close the window and remove the sample from the instrument. Clean the surface and 
begin the process with a different sample.  

6.6.22 Save a digital copy of the spectrum with identified matches as a PDF by clicking on the 
print button, and choosing the Adobe PDF option.  

6.6.23 Save the PDF file with a standard filename that includes the date, sample ID. 
(mmddyyyy Sample ID) For example (10102019 DI Water Blank) 

6.6.24 The file should be saved in a FTIR folder, in the specific study folder created by the PM 
in F: drive. If there is no FTIR folder under the specific study create a new one. 
F:\EAP\TSU\ProductTesting\SpecificStudyName\FTIR  

6.6.25 Once the PDF has been saved print a hard copy for records.  
6.6.26 Save the .SPA file by clicking on the File tab located on the top left side of the screen 

and choosing “Save As.” Use the same filename format and location mentioned above 
to save the .SPA file in the same study specific folder 

6.6.27 Once all the samples have been screened all PDF files of individuals scans are to be 
combined into one document and uploaded into the study page in the PTDB. The 
combined PDF document is saved as “FTIR screening results for Study Name” 

6.6.28 Note: PTDB limits the size of the files that can be uploaded at 20Mb. Break down 
combined PDF documents that exceed the size limit into multiple documents before 
uploading. PM’s may also choose to compile PDFs based on a certain criteria, and 
upload these as additional files.  

6.6.29 Optional: A separate word document with a case narrative from the notes recorded in 
the FTIR Error Log and any other observations noted by the analyst is also uploaded to 
the PTDB.  

6.6.30 Please refer to Product Testing’s SOP for Data Entry and Data Entry Quality Assurance 
for steps on how to upload documents to the PTDB. 

7.0 Records Management 
7.1 All records and logs mentioned below are to be stored in the Product Testing Prep 

Room. (ROL-21) 
7.1.1 FTIR Instrument Log (Maintenance Records) 
7.1.2 IDC and FTIR Performance Verification Record Log ( Record of IDC  and Performance 

Verification (PV) Tests) 
7.1.3 FTIR Daily Log (Record of samples scanned) 
7.1.4 FTIR Error Log (Record of errors during screening) 

7.2 Other records as specified in the sections within this SOP  

8.0 Quality Control and Quality Assurance 
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8.1 Instrument Verification: 
8.1.1 A monthly Performance Verification Test based on ASTM E1421 standard practice 

ensures that the spectrometer is in good working condition and can be used to screen 
samples.  

8.1.2 The Performance Verification Test aligns the spectrometer, verifies the laser frequency, 
checks the energy throughput, and uses a NIST-traceable polystyrene film located 
inside the spectrometer to confirm wavenumber accuracy.  

8.1.3 The table below identifies the wavenumbers at which the performance verification 
confirms the wavenumber accuracy for an internal 1.5 mil polystyrene sample. 

Wavenumbers (cm-1) High 
Limit  

Low Limit  Measured  Result 

Peak at 3060  3061 3059 3059.126 Pass 

Peak at 1601.2  1602.2 1600.2 1600.802 Pass 

Peak at 1028.3  1029.3 1027.3 1028.244 Pass  

Table 2. Wavenumber accuracy for internal polystyrene standard 

8.1.4 An example copy of the whole performance verification page that is printed and filed in 
the FTIR performance verification folder in the prep room at the beginning of each 
month is available at Product testing SharePoint site.  

8.1.5 In case of Performance Verification Test failure, refer to manufacturer 
recommendations available in the “Nicolet iS5 Spectrometer Fast Facts Sheet” available 
in the Department of Ecology, Sample Prep Room (OL-21). 

8.2 Sample Check Verification for FTIR analysis: 
8.2.1 Sample check verification is to be conducted at least once every day before using the 

instrument for screening.  
8.2.2 Sample check verification first verifies the wavenumber accuracy by checking for the 

presence of specific peaks associated with ortho-phthalates. The presence of the peaks 
at ± 5 wavenumbers is acceptable and is labeled as a passing result.  

8.2.3 Then, the spectrum of the check verification samples are matched to the spectral library 
for positive identification of phthalates. A positive match of greater than 60% for all 
identified phthalates is considered to be within the desired standard.  

8.2.4 Note: Make sure that the spectral library that is chosen for matching the spectra is 
consistent in every search.  
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8.2.5 *Disclaimer: Previously analyzed laboratory samples (CHK SMP1 and CHK SMP 2) 
used in the process for verifying the instrument’s ability to identify the class of ortho-
phthalates were analyzed using methods that have been updated by the WA State 
Accreditation Board. These samples are used to roughly demonstrate the instrument’s 
ability to screen for phthalates, and are not to be considered as standards. 

8.2.6 The method listed in this SOP can be used to screen for the presence of phthalates only 
when the presence is greater than 10%. Therefore, the results obtained cannot be the 
only determining factor in selecting the product for further analysis. 

8.3 Data Collection:  
8.3.1 Collection of a background signal is essential for the instrument to generate a spectrum 

for a sample screened. Make sure that the crystal surface is clean and dry before 
collecting a background. The pressure clamp needs to be loosened to ensure that the 
plastic tip is not touching the crystal surface when the background is being collected.  

8.3.2 Any errors or abnormal incidents such as errors in sample ID, incomplete scans or bad 
spectrum due to improper tightening of the pressure clamps etc. should be recorded in 
the FTIR Error Log book.  

8.3.3  Make sure to clean the surface and the plastic tip in between samples. Allow time for 
the surfaces to dry off before placing another sample. 

8.3.4 Use forceps or tweezers to replace samples in and out the crystal surface to reduce the 
need for changing gloves after each sample. Make sure to clean the forceps with Kim 
wipes and alcohol in between samples. 

8.4 Data Upload:  
8.4.1 Once all the samples have been screened all PDF files of individuals scans are to be 

combined into one document using the Acrobat Reader and uploaded into the study 
page in the PTDB. The combined PDF document is saved as “FTIR screening results 
for Study Name” 

8.4.2 Please refer to Product Testing’s SOP for Data Entry and Data Entry Quality Assurance 
for steps on how to upload documents to the study page of PTDB. 

8.4.3 Optional A separate word document with a case narrative from the notes recorded in the 
FTIR Error Log and any other observations noted by the analyst is also uploaded to the 
study page of the PTDB.  

8.4.4 The project manager (PM) will inspect datasets uploaded to the Product Testing 
Database (PTDB) to verify accuracy, completeness, and adherence to the specific study 
criteria. 

9.0 Safety 
9.1 Where QAPP specific preparation procedures require the use of the hazardous materials 

the Ecology Chemical Hygiene Plan and Hazardous Material Handling Plan (Ecology, 
2018) which includes the laboratory Safety Orientation, Job-Specific Orientation and 
Chemical Safety Procedures must be reviewed. The standard Operating Procedures in 
Section 16 of the Chemical Hygiene Plan and Hazardous Material Handling Plan for 
handling chemicals must be followed. 



 

PTP005, Version 1.1 — Revised April 2021 
Uncontrolled copy when printed 

— Page 27 — 

9.2 Protocols for sample preparation safety is discussed in Product Testing Sample 
Collection and Processing Standard Operating Procedure, EAP PTP001. 

9.3 Laser Safety: 
9.3.1 The instrument uses an 850 nm diode laser that emits radiation invisible to the naked 

eye. A protective housing covers the instrument and >80% of the laser light is lost as it 
passes through the instrument optics. Exposure to reflective laser radiation is less than 
200 µW during normal use and maintenance. Never stare into the laser beam or at its 
bright reflection. 

9.4 Instrument Safety:  
9.4.1 The FTIR is generally left on, even when not in use. The FTIR should not be covered or 

pushed up against the wall; internally generated heat is vented at the back of the 
instrument and care should be taken to not obstruct this vent.  

9.4.2 Long-term stability of the instrument improves with the length of the time the 
instrument is on, so turning it off is not necessary. 

9.4.3 The instrument is sealed and desiccated to help prevent damage to the optics or other 
internal components. Check the desiccant indicator located at the back of the instrument 
before every run to check for the need to change desiccant.  

9.4.4 Do NOT use acetone or strong acids and bases for cleaning the crystal surface. Any 
samples suspected of having these compounds should not be screened using the FTIR. 
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Appendix A 
Familiarization with the Nicolet iS5 FTIR Spectrometer 

 

 

  

Figure 20. Nicolet iS5 spectrometer 

Figure 21. Spectrometer features 



 

PTP005, Version 1.1 — Revised April 2021 
Uncontrolled copy when printed 

— Page 30 — 

Appendix B 
Identifying System Status and running a Performance Verification Test  

At the adjoining computer, log on with your User Name and password, then open the “OMNIC” icon 
on the Desktop. The software works from any user ID. Collected data can be stored on the computer in 
any user-defined study-specific F: drive folder. For product testing studies a specific FTIR folder is 
created under each study in F: drive. 

After opening the OMNIC software, check the System Status by reviewing the System Performance 
Verification shield icon in the upper right corner of the Omnic software interface. 

A green icon indicates that the status is good and no action is needed.  

A yellow icon indicates there is a problem detected but it is not serious and corrective action 
may be required. Any minor issues should be checked to determine if it has any effect on the quality of 
the data. 

 A red icon indicates that the system is out of specification or a subsystem failed. Most often it 
indicates that the last PV test did not meet specifications, or a monthly PV test has not been performed.  

Follow steps below for running the Performance Verification test: 

1. Click on the red system status icon which opens the following dialog box.  

 
Figure 22. System Status Overview 

2. Click the Performance Verification button. This displays the last date when a PV test was run 
and the date after which it expired. 
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Figure 23. Performance Verification 

3. Click Run. On clicking the run button Omnic prompts (Laser Verification) you to remove the 
accessory in the sample compartment. Carefully remove the iD5 ATR accessory and place it on 
clean Kim Wipes. To remove the accessory, carefully grasp it by the handles and lift straight 
up. (as shown below) Click OK on the new prompt that appears on removing the iD5 ATR 
accessory. Next, Click OK on the Laser Verification prompt.  

4. Note: Make sure there is always an accessory installed on the instrument. When not using an 
accessory, store it in a dust-free environment, such as in a box inside the FTIR cabinet in the 
Product Testing Prep Room. 

Figure 24. Removing an accessory 
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5. The procedure aligns the spectrometer, verifies the laser frequency, checks the energy 
throughput, and uses a NIST-traceable polystyrene film located inside the spectrometer to 
confirm wavenumber accuracy. The PV test is based on ASTM E1421 standard practice and 
takes about 6 minutes to complete. 

6. The performance verification process goes through a series of windows and messages detailing 
each step. You may hear the motor rotate the internal polystyrene sample in and out of position 
while the system measures the polystyrene spectrum.  

 
Figure 25. Performance verification complete screen 

7. After the performance verification has been completed print the report by clicking on Report 
button then select print. 

8. The FTIR analyst should sign and date the performed by portion of the Performance 
Verification Test Log and add it to the FTIR Performance Verification Log Book.  

9. Once the report is printed the System Status icon should turn Green. Close all windows and 
insert the iD5 ATR accessory to begin using the equipment for running sample verification and 
screening samples.  

10. Once the iD5 accessory has been installed a prompt appears on the screen which specifies the 
accessory installed and the experiment loaded. Click Ok to run a performance test that verifies 
that the accessory has been inserted correctly. 

11. A prompt comfirms the accessory passed the performance test.  
12. Return to Procedure. 
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Appendix C 
Standard peaks for identifying ortho-phthalates 

1. Given below is a spectrum of dioctyl phthalate (DOP), also known as di (2-ethyl hexyl) 
phthalate:   

 
Figure 26. IR spectrum of DOP with characteristic ortho-phthalate peaks 

2. It is characterized by the following bands that are characteristic of all ortho-phthalates. 

Table 3. Information on the wavenumbers associated with characteristic ortho-phthalate

Vibration modes  Wavenumber ( cm-1) Comment  
VC = O 1725 Very intense  
V1

ring 
V2

ring 

1595 
1580 

Weak doublet band, sharp and of nearly equal 
intensity  

Va
C-O-C 1280-1290  Very intense Split  

Vs
C-O-C 1120  Intense  

 1070  Intense, Sharp  
ɷ4H adjacent  740 Medium, Sharp  
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Laboratory measured verification sample information 

3. The table below provides information on the samples with known amounts of ortho-phthalates, 
being used to verify the ability of the instrument to detect the presence of ortho-phthalates. 
These samples also set the current limit of detection (LOD) of the instrument to 13%. 

Table 4. Check verification samples  

Sample 
Component 
ID 

Extraction 
method 
used  

Analysis 
Method 
Used  

Most Significant 
Phthalate Identified  

Analysis 
Value  
(mg/Kg) 

Analysis 
Reporting 
Limit 
(mg/Kg) 

Analysis  
Lab 

MK-5-25-3 
CHK SMP 1 

CPSC-
CH-
C1001-
09.3 

SW8270
C 

Diisononyl phthalate  130,000 10,000 BSK 
Associates 
Analytical 
Laboratory 

SL-1-29-1 
CHK SMP 2 

SW3546 SW8270
D 

Di (2 ethyl-hexyl) 
phthalate 

160,000 2500 Dept. of 
Ecology 
Manchester 
Environmental 
Lab 
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Appendix D 
 
When do you need a new background?  
The CO2 and humidity levels in the air near the spectrometer will change over time. This will cause 
absorption features, negative or positive, to show up in your sample spectrum because the sample 
spectrum is being ratioed to a background that had slightly different levels. If you start seeing CO2 
peaks around half the height of the main peaks in your samples, you should take a new background.  
Water vapor is typically more disruptive. So, if you see water vapor peaks that are taller than perhaps 
5% of the tallest peak in your spectrum, you should get a new background.  
See Figure 27, where CO2 is much too strong and water vapor is making a mess of the important 1400-
1800 region. You can collect a new background anytime--you don’t have to wait for the reminder.  

 
Figure 27. Example of a polyurethane sample that needs to be redone because it needs a new background. 

Figure 28 shows the same sample with a proper background. 
  



 

PTP005, Version 1.1 — Revised April 2021 
Uncontrolled copy when printed 

— Page 3 — 

 

 
Figure 28. Polyurethane sample with appropriate background. Note the smooth baseline. 
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